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Introduction

Introduction to TACTIC

What is TACTIC?

TACTIC is an extensible, web-based data and file management system. TACTIC centralizes the following aspects
of digital project workflow:

• Production data management

• Scheduling

• File (Asset) Management

• Communication

• Reporting

• and more

How does TACTIC work?

TACTIC manages two aspects of Digital Content Management: Project data and Files. TACTIC maintains both of
these components in one unified source.

Project Data Project data is stored
in the Database

Project Data is the information and lists that are traditionally tracked in
spreadsheets. TACTIC has the ability to list all files you manage along with
task assignments, status', and scheduling data, which can be viewed in simple
table formats or complex custom reports. TACTIC eliminates lost email
threads, missing documents, and the need to update complex spreadsheets.
The "database" is the base location for all data. i.e. notes, reports, schedules
etc. What a database provides is a central location for this information.

Content/
Files

Files stored in the File
System

Content refers to the actual files. When managing assets/files the directory
and file naming, along with proper version control is what makes TACTIC
unique. Files in TACTIC are managed externally in a file system. i.e. hard
drive. The file server typically has a root 'assets' directory. From this location,
TACTIC handles the filenames and directories for that file system.

What can I do with TACTIC?

End-Users have various roles within a project or organization. The TACTIC interface can be moulded to provide
each group (department) with the ideal interface.

The TACTIC security architecture is a rules-based system where each End-User is provided with a login. The End-
User is assigned to groups determined by the project leader or administrator. These rules determine what the End-
User has access to within TACTIC.

Communication between groups and departments can be tracked in real-time by using the TACTIC Notes
functionality. This method eliminates lost email threads and misplaced documents.

TACTIC can manage limitless amount of tasks, the status of those tasks and the location of all files being managed.
TACTIC gives the End-User an accurate real-time understanding of how a project is progressing.
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The table below illustrates how various End-Users may interact with TACTIC in a single organization.

Content Creator The Content Creator often requires a view of all tasks assigned. The user can update a
status, check in and check out files, log work hours and communicate with Supervisors
using the Notes widget.

Supervisor/Manager The Manager/Supervisor is often required to schedule tasks, manage content and
resources. The project schedule can be adjusted in the User Schedule or Project Tasks
view. The TACTIC interface provides high level planning, communication and reporting
tools. The Supervisor often has access to all views which provides the ability to plan and
adjust the overall needs of a project quickly and easily.

Client Clients often need to review project material (documents, videos, images etc) and
managing this continuous feed of content is often a hurdle. TACTIC's built in web
technology allows Clients to deliver files and provide real-time feedback without FTP or
Email. TACTIC can provide Clients with only the specific views and permissions needed
for each project.

Executive Executives require a high level view of the project. This often involves building views
or "reports" that correlate data from all aspects of the project. TACTIC is able to provide
cost reporting, completion, efficiency and location of bottlenecks.

What can I do in TACTIC?

TACTIC is a transaction system allowing users to search, interact, update and report on project data and files. These
interactions are carried out using a few main operations:

• Search - Search query results are often displayed in a list where you can interact with your project data.

• Insert - Additions or "Insert" new data is often done at the start of a new project. This is done through various
interface tools like forms, multi inserts, CSV import and more.

• Update - Updating existing data is sometimes required. For example; updating a status, adding keywords, or
changing an assigned user. Specific views and tools also allow for selecting multiple items to edit at one time.

• Check-in - Part of TACTIC's power is the ability to check in and manage your files/assets. When you do a check-
in, TACTIC versions and names the directories and files in your file server. Files remain organized and will never
become lost.

• Check-out - When you need to work on some files that are already checked into TACTIC, you can check them
out. This process either points you to the where the files are located, or downloads them to your computer.

• Undo/Redo - Every action carried out within TACTIC can be undone. If a mistake has been made, simply undo
the transaction.

How do I access the TACTIC interface?

TACTIC is delivered as a web site. This web based solution is extremely powerful because it allows for full interaction
with TACTIC and also direct integration with supported software packages.

Accessing TACTIC is as simple as visiting your server's address (URL) in your web browser. For example:

http://yourcompany.southpawtech.com

Lets Get Started!

The following End-User documentation provides general usage of the TACTIC feature set. Additional information,
tutorials, forums and documentation is available on our TACTIC Community site:
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http://support.southpawtech.com
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TACTIC Startup

Setting Up Your Web Browser
Web Browser

To access the TACTIC interface, a supported version a web browser is required.

To connect to the TACTIC server, type a URL in your web browser similar to the example below (the IP address
will vary depending on the network setup of your organization). An example is shown below:

http://192.168.14.198/

When you are connected to the server, you are presented with the TACTIC login screen:

Note

If you cannot see this TACTIC login, please contact your TACTIC Administrator.

Java Support

For certain transactions to occur between TACTIC and the client computer, Java will need to be installed. Currently
TACTIC supports: Java JRE 1.6.0+

To download the Java Runtime application, please visit:

http://www.java.com

http://www.java.com
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Interface Map
When you log in to TACTIC from your browser, you will see a window similar to the following image. This section
describes some of the important parts of this window.

1 - Header

1a Project
Homepage Link

The project bar shows the TACTIC logo and release. This link will also direct you back to
the project selection page.

1b Project
Thumbnail

This area shows the name of the project and thumbnail.

1c Project Selection
Menu

A drop down list to switch between projects.

1d Main Action
Menu

Main TACTIC Actions menu.

1e User Menu Allows for editing of basic user settings

1f Main Help Link Loads the Built in TACTIC Help (documentation, links etc)

2 - Sidebar

2a Project
Views

Project Views contains links to different views with information about the project as well as
workflow.

2b My Views My views is a collection of views that are custom created by the login user for personal use.

2c My Admin My Admin displays the Tactic system, as well as the project and adminstration schema. Access
to this part of the sidebar is generally reserved for admin level users.
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3 - Main View Panel

3a Tabs Tactic supports loading multiple tabs, similar to how web browsers handle tabs. Views can
be loaded into tabs either automatically or through right-clicking on a link.

3b Simple Search In some views, a simple search will be included. The Simple Search option provides a quick
and easy way to search specifically within the current view in use.

3c View Toolbar In some views, there will be tools which are specific to the view. For example, the "Table"
view provides an array of tools for interaction with that table.

3d Main Panel The Main Panel is where the actual results of the view are displayed. This can be a table,
tile tayout, dashboard etc.
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TACTIC Gear Menus

Top Gear Menu

Add

Add New sType Add a new sType to the schema.

Add New <...existing sType from schema...> Open a new tab and pop-up a window to insert a new item
of the existing sType from the schema.

Edit

Undo Last Server Transaction Undo the last transaction.

Redo Last Server Transaction Redo the last transaction.

Show Server Transaction Log Display the Transaction Log in a pop-up. The log holds
all the transactions since the creation of the project.

Tools
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Web Client Output Log Load the Web Client Output Log. This log details
TACTIC output as well output from statements in scripts.

TACTIC Script Editor Load the TACTIC Script Editor pop-up.

Help

Documentation Open a new page to TACTIC's Documentation.

TACTIC Support Community Open a new page to TACTIC's Support Site.

Gear Menu for the View

Edit

Retire Selected Items Retire the selected items. Retired items are hidden from
the view, but not removed from the database.

Delete Selected Items Delete the selected items. Deleted items are removed
from the database and are no longer available.

Undo Last Server Transaction Undo the last transaction

Redo Last Server Transaction Redo the last transaction

Show Server Transaction Log Load the TACTIC Transaction Log. The Transaction Log
holds all the transactions since creation of project.
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Add Tasks to Selected Add tasks to the selected items.

Add Tasks to Matched Add tasks to the matched items.

File

Export All ... Export all of the item in the view.

Export Selected ... Export all of the selected items in the view.

Export Matched ... Export all of the Matched items in the view.

Export Displayed ... Export all of the displayed items in the view.

Import CSV ... Import a CSV file.

Clipboard

Copy Selected Copy the item that is selected in the view (indicated with
a check mark) to the clipboard.

Add Selected Add the item that is selected in the view to the list of items
already on the clipboard.

Paste Clipboard Paste the items from the clipboard to the current view.

Show Clipboard Contents Display the contents of the clipboard in a pop-up window.

View
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Column Manager Pop-open the Column Manager.

Create New Column Pop-open the Create New Column Window

Edit Current View Edit the current view.

Save Current View Save over the existing view with the current
configuration.

Save a New View Save the current view as a new view in the sidebar.

Print

Print Selected Print all the selected items in the view.

Print Displayed Print all the displayed items in the view.

Print Matched Print all the matched items from the search criteria.

Chart

Chart Items Create a chart of displayed view.

Chart Selected Create a chart of the selected items.

Tasks

Show Tasks Add the Task Edit column to the view.
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Add Tasks to Selected For the items that are currently selected in the view, add
tasks to them.

Add Tasks to Matched For all the items returned by the search, add tasks to them.

Notes

Show Notes Add the Notes column to the view.

Check-ins

Show Check-in History Add the Checkin History column to the view.

Show General Check-in Tool Add the General Check-in Tool as a column to the view.

Pipelines

Show Pipeline Code Add the Pipeline Code column to the view.

Edit Pipelines Open the Workflow Editor in a new tab.
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TACTIC Sidebar

Description

The TACTIC sidebar is the main menu system for navigating through the views in the TACTIC Project. The access
rules applied to a specific account determine the contents of the sidebar as well as which views are displayed when
a user is logged in.

The items in the sidebar provide links to existing views within a project. These views are built by your organization's
production manager based on a selection of columns (properties), layouts (order and column width) and a search. If
a search view is available, it provides a dynamic report based on the definition of the search.

The sidebar is divided into three different categories, "Project Views", "My Views" and "Admin Views".

Project Views and My Views

The Project Views provides a way to save project wide views that everyone across the entire
project would want to see. It also has a manageable list of custom user views.

The Project Views can be defined by the person in the role of the project manager. Views
can also be hidden from specific user groups.

My View contains a list of links to views that were created by the login user themselves.
These usually are created by the user to cater to their own personal work flow.
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Admin Views

Admin Views displays the project schema and the TACTIC system and administration schemas. Access to the Admin
Views section of the sidebar is generally reserved for admin level users.

My Admin - My Admin holds views that will allow the users to manage My Views and My Preferences.

Manage My Views Edits the views saved in the "My Views" section.

My Preference Preferences include: Debug, Web Client Logging Level, Color Palette, Language,
Quick Text for Note Sheet Thumbnail Size
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Preferences

How to Change Your Password
1. Log in and go to the top right hand corner of the screen. The name of the current user logged into TACTIC session

is displayed here. Click on the button labelled "My Account". From the context menu, select "Edit My Account".

2. Type in the new password and re-confirm it in the following field.

Modify any other account information that needs to updated and hit Save.
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Views

What are Views?

Views in TACTIC are the main widgets used to display the items in a project. The display of these items vary
depending on the view. Views are typically accessed through the sidebar. TACTIC tools and widgets such as tables,
dashboards, edit panels and custom HTML interfaces, allow the end user to interact and alter the viewing experience.

TACTIC Views are extremely customizable and can be configured to meet the specific needs and workflow of the
end user. Views also provide quick navigational options such as Search and Grouping, which can be embedded in
various layout styles within a panel interface such as a Dashboard.

Below are some examples of the more common widgets used for views in TACTIC.

Table

Dashboard

Edit Panel

Budget

Calendar
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Views Quickstart
Loading Views

To get started with view, first load a view from the sidebar in your project. Ideally you will have a view with some
items available.

If the view is a Table based view (which is the most common), you will notice that there is an arrangement of columns
with tools and data.

Inserting and Editing Items

To insert a new item, click the  button in the View Shelf

To edit items, click the cells in the table, or right click on an item and choose "Edit".

Gear Menu Options

Selecting items allows for certain actions to become available in the View Gear Menu. For example "Tasks -> Add
Tasks to Selected"
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View Layouts

To change the layout of the view, click the Layout Switch button. Each view provides different information and tools.

Add/Remove Columns

To Add Columns to the view, click the Column Manager button in the shelf or, right click in the table header and
choose "Column Manager"

or



TACTIC End User

20

Insert

Introduction

TACTIC provides many ways to insert new items. For the beginner, insertion of a new item can done through a form
that guides you through each input field. For the more advanced used, insertion of an item can be done directly inline
in the view. The various methods to insert items are described below.

The Insert Menu Options

The insert button is on the tool shelf. It is the button with the green circle, with a white plus sign inscribed. Clicking
on the button bring up a form to guide you through each input field. The down arrow triangle next to the button allow
you to do the insert in different ways.

Each option of the Insert menu is described in detail below.

Add New Item (in Page)

This insert menu option adds a new row directly into the page that you are viewing. The advanced user would be
more comfortable using this method.

Once in this insert mode, refer to the column headers as a guideline as to the type of data to enter into the input field.

All input fields are optional. If no data is entered into an input field where one would be required, such as Code, an
appropriate default will be automatically generated.
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note: Hitting the green plus sign will insert multiple rows into the view. This facilitates inputing data for multiple
new items quickly.

Add New Item (Form)

This menu option open a window which guides you through the data to enter for each input field. This method of
inserting an item is a good place to start for the beginner.

Once the insertion form pops up, the description on the left hand side can be used as a guide as to the type of data
to enter into the input field.

All input fields are optional. If no data is entered into an input field where one would be required, such as Code, an
appropriate default will be automatically generated.

Add Multiple Items

This menu option opens Multi-Insert the pop window.
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The Multi-Insert pop-up window, allows you to add the same item multiple times.

The most important value that must be entered is one for the Multiplier field.

The number entered into the Multiplier box determines how many items that will be created.

Sequence code will determine which sequence the items will be placed under.

The Code value will be incremented by the value that is entered into the Multiplier.

*Note - The value for Code must start with a letter.

All the other values are optional.
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Edit

Introduction

The following describes how to edit the data in various views of TACTIC.

Editing Using a Form

To edit a row of data, right click anywhere on the row and select "Edit" from the context menu.

A form pop-up to edit the data will appear. The description on the left side indicates what data to enter into the input
fields.

Editing Inline

Clicking on a field within the row allows editability only if edit mode for that column is enabled.

Below is a few examples of edit modes for the various widgets:

The edit mode for the Text Widget is most common. This widget allows keyboard entries into editable fields.
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The edit mode for the Selection Widget is displayed below. The widget restricts your input choices to the options
in the drop down selection menu.

The edit mode for the Calendar Widget is displayed below. The Calendar widget pops-up a monthly calendar for
convenient date selection.

Multi-Edit

To modify the more than row so that they all have the same data, first check mark the rows to be edited.

Left click on a cell in the column to be edited. The row will go into edit mode.
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Once the text is entered, click off the cell. All cells selected will have the same data.

Delete and Retire

Introduction

TACTIC provides many ways to delete and retire items directly from the view. Retiring is TACTIC's way of marking
an item so that it does not appear in any searches, but allows the user to bring it back if necessary. The methods to
delete and retire an item are described below.

Deleting from the Context Menu

To delete an item from the view, first put a check mark in the box next to the item you want deleted. Then, right
click anywhere on the row to bring up the context menu. Selecting the "Delete" option will delete the object from
the view and from the database.

Deleting from the Gear Menu

Alternatively, the gear menu can be used to delete an item from a view.
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1. Put a check mark in the box next to the item.

2. In the tool shelf and click on the gear to bring up the gear menu.

3. Selecting the "Delete" option will delete the object from the view and from the database.

Note
If an item is deleted by mistake, to undo this action, go to the top gear menu, select Edit -> Undo Last
Server Transaction.

Retiring from the Context Menu

To mark an item as "Retired", first put a check mark in the box next to the item. Then, right click anywhere on the
row to bring up the context menu. Selecting the "Retire" option will mark the object as retired and filter it out from
the view.

note: Items will still exist and can be brought back. The next section will shows how to view items that have been
marked as "Retired".

Retiring from the Gear Menu

To retire an item from the view using the gear menu:
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1. Put a check mark in the box next to the item.

2. In the tool shelf and click on the gear to bring up the gear menu.

3. Selecting the "Retire" option will mark the object as retired and filter it out from the view

Note
The item will still exist and can be brought back. The next section will shows how to view items that have
been marked as "Retired".

Showing Retired Items

When an item is "retired", it has simply been marked as "retired" in the database. The item still exists in the database
and can be brought back. To show items that have been retired in a view, go the any column header and right click.
This will bring up a context menu. Select "Show Retired".

Note
The items marked as "retired" appear highlighted in red.



TACTIC End User

28

Creating and Editing Views

TACTIC provides the following configuration display options when creating or editing a view:

• Which columns are part of the view

• The order of the columns

• The width of each column

• The Grouping of the items

• The Search which has been applied to the view

In TACTIC, there are 2 main distinctions between the types of views Project Views and My Views. These are
presented in 2 sections within the main sidebar.

• Project Views - Project views are presented to all users in the production and/or can be hidden based on group
access rules. Project views are also generally only created by the project manager and the ability to save and modify
them can also be blocked with group access rules.

• My Views - My views are views saved per user. It allows for saving of personal views outside of the project views.
These will only be available to the user who created them.
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Adding Columns

To add a column, right-click on any column header in the view.

Select the Column Manager

In the column manager, selecting columns will add them to them current view. The sections in the column manager
are as follows:

• Custom Widgets - These are the custom widgets which have been defined for the current type. These represent
both changes to information (i.e.. switching a code) as well as tools which represent certain actions for that type
(i.e.. a button which loads the asset into an application)

• Common Widgets - These widgets are similar to the ones above but, are common to all types in TACTIC. They
are tools which are generally universal.

• Raw Database Columns - These are the raw data (property) columns which exist for the type. Generally, each
is represented by a Property Column but, this allows adding of the data in its raw format. For example, a task has
'start_date' and 'end_date' database columns but, there may be a 'schedule' column which displays the start_date
and end_date together in a calendar widget.

Note

Certain widgets require Java to be started up so, it can take a few seconds for the selected column to
actually appear in the view. When finished, click the close button.
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Removing Columns

To remove a column from the current view, left click in the column header for the column to be removed and choose
Remove Column. Columns can also be removed through deselecting them in the column manager.

Ordering Columns

To re-order columns, click and drag a column in the header to the desired location in the view. As the column header
is dragged to the left or the right, an orange bar will appear between the columns indicating where the column appear
if the mouse button is released.

Resize Columns

To resize a column width, hover the pointer over the divider between the column headers and the mouse pointer will
change to a width adjuster.

Left click and drag the width adjuster to change the width of the column.
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Grouping

Some columns in TACTIC contain categorical data. Some examples include 'status', 'parent', 'assigned user' columns.
These columns can be grouped.

For example, grouping by the Assigned User column displays the items in groups by each user.

To apply grouping to a view, left click on the column header to be grouped and choose Group By
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Search

The Search Tool is used as a filter to only display items which match a certain criteria. This allows the results in the
view to be narrowed down. When a view is saved, the search criteria is saved with the view which causes the view
to become a live report as each time the view is loaded the search filter will be applied to the live data.

For example, if a search filter is created which shows only items which have a child task with the status "Review",
the view will provide a report of all items which need to be reviewed. When the status of these tasks are changed,
the items will be filtered out and no longer appear in the view.
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Saving the View

After the display of the view have been configured, to save the view, go to the gear menu under View. The options
are described below.

• Save Current View - Saves over the existing view. (Available only to users with access to save project views.
Otherwise, it will save a new My View)

• Save As New "My View" - Saves the view to the user's personal My Views. (Available only to users who can
create views)

• Save As New "Project View" - Save a new project view which will be available to all users. (Available only to
users with the appropriate access.)

• Edit Current View - Opens up a pop-up window to edit the table and the columns.
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Searching

What is Searching?

With the basis of TACTIC being data (information) storage, a large aspect of working with TACTIC is searching.
When looking for items in the project, specific properties are used when conducting a search. Below are some example
of typical searches in TACTIC:

• Tasks with status in review

• Find items by category

• Search by Keywords

• Tasks Due this week

• Tasks Past Due

• Work entered in the current week

• ....and more

Often times, these searches are used daily so having to fill out the search criteria could be redundant. In TACTIC,
views can be saved as links in the sidebar which include the search criteria. This in turn causes the view to become
a live report which is always up to date.

Searches in TACTIC are carried through 2 primary interfaces:

Simple Search

The simple search allows for a simple set of search options for a view.

Search Box (Advanced Search)

The Search Box can be used to execute simple to very complex searches.
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Search Quick start

TACTIC provides two main search tools; the Simple Search and the Search Box.

Simple Search

The Simple Search provides a view specific filters. To use the simple search:

1. Load a view of items in your project. In this example a Keywords field is provided and an Asset Category drop-
down narrows down the search even further.

2. Fill in the desired search and click the search button.

3. The results view will automatically refresh once the search is complete.

Search Box

The Search Box can be used to conduct more complex searching in TACTIC. To test a few examples, load a view of
items in a project which have Tasks. In this example the view is an Asset view.

1. To Search for all assets with an asset category of 'video' , in the following criteria;

Filter -> "Asset Category" "is" "video"

2. To Search for all assets with an asset category of; 'video', '3d', and 'document', enter the following;

Filter -> "Asset Category", "in", "video|3d|document"
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3. To search all assets described in example 2 and also include tasks that are approved, enter the following;

Filter -> "Asset Category", "in", "video|3d|document"

Children -> "Task", "Status", "is", "Approved"

4. To find all tasks assigned to the user currently logged in, a simple expression can be used;

Children -> "Task", "Assigned", "is", "{$LOGIN}"

5. To find all assets with a category of 'video' and keyword of 'car' or a code that contains 'car';

Set the top option in the drop-down box to "Compound Search";

Filter -> "Asset Category", "is", "video"
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and (click between the filters to activate the and/or)

Filter -> "Keywords", "contains", "car"

or (shift-click between the filters to group the filters)

Filter - > "Code", "contains", "car"

6. To execute complex searches using an expression to find all assets which have check-ins with versions higher
than 1;

Filter -> "**Expression", "have", "@SOBJECT(sthpw/snapshot['version', '>', 1])"
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Search Interface

Description

The TACTIC Search Box is used to build filters to refine the results in the view. A variety of search filters can be
constructed, ranging from simple column searches to large complex compound searches. The creation of search filters
closely resembles that of creating mail filters in a mail application. Each search filter plays a role in the outcome of
the final results. The Search Box is flexible enough to handle any kind of search.

Keyword Search

Open the Search Criteria by clicking the  button on the tool shelf.

The keyword search section allows for creation of a search filter to search on the words found in the column named
keywords. These keywords must be manually inputted and updated.
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Filter

The Filter section allows for the creation and activation of search filters. Each search filter operates on one attribute
on that sType. These searches use standard text search logic and supports TACTIC's expression language.

The Clear button clears out all the data in all the search filters: resets the drop down selection boxes and clears out
the input search criteria box.

Parent Search
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A search can be based on any property of a parent search type. For example, if asset_category is the parent type
then a search can be made based on the properties of the parent. For example, a filter can be created on the parent
(asset_category) where the code is "video".

Children Search

The Children search filter allows refining based on data in columns in the children. For example, a filter can be
created to find all tasks where the priority is greater than 3.

Matching and Compound Searches

Click the [+] icon beside a search parameter to add additional search definitions.

The drop down selection box at the top of the search box can be used to set up the search to be match open (matching
any of the definitions) or match specific (matching all of the definitions). The default match option is "Match all".
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Compound Search gives the capability to set an AND or an OR option for filters. The default compound search
option is "AND".

To switch the compound search option, select "Compound Search" from the drop down selection box at the top, add
a new search filter, click on the word "and" that appears between the search filters to toggle it to "or".

Operators

is Finds an exact match. eg. Process "is" Compositing

is not Finds all the results that do not match exactly. eg. Process
"is not" Compositing

contains Does a partial match. eg. Process "contains" ompost
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does not contain Finds all the results that do not match a partial match.

is empty Match the empty field.

starts with Match on the beginning part of the string. eg. Process
"starts with" Comp

ends with Match the ending part of the string. eg. Process "ends
with" ing

in Match any of the strings delimited by "|". eg Process "in"
Compositing|Lighting

not in Find all the results that do not match the strings delimited
by "|".

is distinct Skip duplicates. eg. Sequence "is distinct".

The "In" Operator

It is possible to search for items in a list using a simple text string with a "|" operator. For example, search for either
"TM_001" or "TM_002" or "TM_003":

Sequence code  [in] "TM_001|TM_002|TM_003"

The vertical bar (a logical "or") is a delimiter that specifies that the search should look for any item with the code
"TM_001" or "TM_002" or "TM_003".
To switch the compound search option, select "Compound Search" from the drop down selection box at the top, add
a new search filter, click on the word "and" that appears between the search filters to toggle it to "or".

The "Is Distinct" Operator

This operator filters out items with the same column value. ie. The results will only contain items that have a distinct
entry in that column.

Sequence code  [is distinct]



TACTIC End User

44

note: there is no need to put any criteria in the box when using the operator is distinct

Saving Searches

When saving a view as either "Project View" or "My View", the search filters are also saved with the view. Once the
view is saved, the next time the view is opened, the search filters will be applied. This makes saving a view essentially
like generating a report with a predefined set of criteria.
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Compound Searching
For some searches, the search filters need to grouped and evaluated in a specific order, in order to achieve the desired
expression. Although not always necessary, this type of "compound" search is useful when complex filtering is
required. Generally, compound searches involve the ability to evaluate a search expression similar to the following
example:

[A or B] and [C or D or E]

Here is an example of a compound search on tasks:

[project, is, "{$PROJECT}"] 
and 
[assigned is, "{$LOGIN}"] 
and 
[status, is "Approved"]
    or 
[status, is "Review"]

This search can be phrased as: "Find all tasks from the current project, assigned to the current user with a status of
Approved or Review".

Note

$PROJECT and $LOGIN are used as variables in the search that are dynamic based on the environment.

To do this type of search in TACTIC, in the Search Box, set the "Match" option to Compound Search:

In this search mode, the choice of filters are all "and" or all "or". Groups of searches can be created by SHIFT-
clicking on a particular "and" or "or" between the search filters.

Example

To create the example above:

1. Load a view of tasks and set the search match setting to "Compound Search"
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2. Add the following Filters

• project_code, is, "{$PROJECT}"

• assigned, is, "{$LOGIN}"

• status, is, "Approved"

• status, is, "Review"

3. Now click the and/or to toggle all to "and"

4. next SHIFT-Click on the "and" after the first and second filters.

5. In the new group, click the and/or to toggle to "or"

6. Run the search.
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Expression Searching

Expression values

The search criteria input for search filters can be TACTIC expressions. To signify to TACTIC that a search criteria
is an expression, wrap the expression in curly braces {}. This signifies to the search engine to evaluate the value as
an expression before sending it to the search.

Having the search criteria be a TACTIC expression allows for many uses of predefined variables in the expression
language.

For example, the following will search for all tasks for this week based on a Sunday to Sunday work week.

timestamp "is after" "{$PREV_SUNDAY}"
timestamp "is before" "{$NEXT_SUNDAY}"

Here is the TACTIC expression to find all of the checkins that have occurred this month:

timestamp "is after" "{$THIS_MONTH}"

Here is the TACTIC expression to find all the tasks for the current project:

project_code "is" "{$PROJECT}"

Note: the curly braces {} around these predefined variables are not needed in the expression mode described below.

Full Expression searches

Full expressions searches are an advanced way of searching for results. For each column, there is an "**expression"
option. This option provides the ability to use the full power of the expression language within a search that are
beyond the capabilities of the search user interface.

The full expression executes an evaluation on this expression then relates the results to the main search. Careful
consideration must be take to refine an expressions so that is as efficient as possible.

For example, search for all of the assets that have model tasks:

@SOBJECT(sthpw/task['context','model'])

This search will first execute a search of all of the tasks that have model. Note that this does a search on all of the
modelling tasks. With a large number of tasks, this operation can be heavy. Care must be taken to minimize the results
of the expression. One way to make the search more efficient is limit the search to just that of the current project:

@SOBJECT(sthpw/task['project_code',$PROJECT]['context','model'])

The expressions can be combined with other filters in any combination so that very complex searches can be achieved.

For example, another more complex search is to find all items with a modelling task assigned to someone in the
"toronto" location (assuming there is a custom property on the login table), we can use:

@SOBJECT(sthpw/login['location','toronto'].sthpw/task['project_code',$PROJECT]
['context','model'])

This works because tasks (sthpw/task) and logins (sthpw/login) are connected through each other through the
"assigned" column in the task table and "login" column in the login table.

There are 4 modes available to the expression search: "have", "do not have", "match", "do not match". These four
searches can be applied to the Shot List page.
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1. Results "have" "@SOBJECT(sthpw/task)" will show all items that have tasks in them. This mode must return
items in the expression.

2. Results "do not have" "@SOBJECT(sthpw/task['context','model'])" will show all items that do not have modelling
tasks. This mode must return items in the expression.

3. Results "match" "@COUNT(sthpw/snapshot['context','model']) > 3" will show all items that have more than 3
snapshots. This mode must return True or False in the expression.

4. Results "do not match" "@COUNT(sthpw/snapshot['context','model']) == 0" will show all items that do not match
the condition where model snapshot count is 0. In other words, it means there is at least 1 or more model check-
in for the shot. This mode must return True or False in the expression.
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Tasks

What are Tasks?
The TACTIC Tasks feature allows for the creation and management of Tasks. Each task in TACTIC include various
properties that define and manage the work-flow of a user. Various markers such as; "Assigned", "Supervisor", " Bid
start date", "Bid end date", and task "Status" enable all designated users real time information on the progress of a
particular task. These tasks can be created aribtrarilry or on individual assets or files. Tasks are often driven by a
pipeline process that a partiular item will move through during it's life cycle.

Other details about tasks:

• Tasks can be assigned to any type of item in a project.

• Tasks can be grouped into milestones. The milestone column is used to categorize benchmark dates for a project.

• Tasks can be assigned to particular users. When a task is assigned to a user, it appears in their My Tasks View.

• Tasks can be associated to a specific time-line. The "Bid start date" and the "Bid end date" column displays when
the user is scheduled to work on a task, and when it is scheduled to be complete.
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• Bid duration (hours) can also be specified for tracking the alloted hours for a given task. These can later be compared
to work hours for efficiency and cost analysis and reporting.

Managing Tasks with a Pipeline

A typical project will have assets that need to be tracked throughout the entire course of the project. If each of those
assets goes through a pipeline with a various number of processes, the Tasks list can become vast quickly, therefore
it's important to filter views based on the needs of the user.

Example scenarios could include:

• A director wants a view that shows all items with a task status that is set to "review."

• A user wants to view only "character" items with task status set to "assigned."

• A producer wants to view all items with task status set to "approved."

• A coordinator wants to see all tasks that are due in the current week.

The Default TACTIC Task Status Pipeline

The default TACTIC task pipeline includes the following status'. Please note that these defaults are easily configurable
to suit the needs of the project:

• Pending: The task is waiting for a user to start working on it.

• Ready: The task status has been set to ready by the supervisor or administrator.

• In Progress: The task is in progress or being worked on.

• Waiting: The user is waiting on some event before he or she can continue working on the task.

• Review: The supervisor is reviewing the task.

• Approved: The task is approved and complete.

• Review: The supervisor has been notified to review a task.
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Tasks Quickstart
After inserting a new item into a project, often the first things to do is to create a new task, assign it and have the
appropriate user work on it.

1. Load any view of items you wish to track tasks for.

2. If the task status edit column is not in your view, you can add it with the column manager or switch the Layout
to "Task Schedule"

3. If no tasks exist, click the (+) icon in the task status edit column. Another option is to select the items and choose
Tasks -> Add Tasks to Selected from the Gear Menu. Both approaches will load the task insert pop-up.

For now, click create tasks to create tasks for all process available in the pipeline.
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Note

If a pipeline has not been setup for the particular Type you will not see any processes available in the
UI. This will require building a pipeline which is covered in the TACTIC Setup Documentation

4. Once tasks are created, you will be able to assign them to users, assign dates, priority etc.
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Creating Tasks

Insert/Edit Tasks

There is more than one way to create new tasks. The following describes explains each way.

Task Menu

Select the item to add tasks to. Then, go to the Gear menu for the view and select Tasks -> Add Tasks To Selected.

Check mark the processes to add the task to and then hit Add Tasks.
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The skip duplicated option skips adding a task that has already been created for that process e.g. if only a task for
design has already been created.

Notice the new tasks added to the Task Pipeline column:

Another way to create a task is to create a task by context. This is provided in the drop down selection menu.

Create task by: Process Displays all the processes to select from, to create a task for.
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Create task by: Context Displays all the contexts to select from, to create a task for.

Create task by: All Contexts in Process Creates all the contexts defined in the pipeline, but only displays the processes to select from, to create a task for.

Task Edit Column

The Task edit column can be used to insert tasks one at a time for a particular item.

Task Status Column

Once an item is created which has a pipeline, the widget will show a green insert button (+). This will load the task
creation GUI to create tasks for the item.

Task Properties

Each Task can have the following attributes.
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Process The currently selected process. Use the menu to select a different process to perform on the current parent asset.

Description A description to identify the task.

Milestone Assignment to a milestone item that represents a specific milestone in the project.

Status The status of the currently selected task pipeline.

Assigned The user assigned to complete the task.

Supervisor The user assigned to supervise the task.

Priority The priority level of the task.

Bid start date Proposed date to start the assigned task. Drag the date in the calendar to set.

Bid end date Proposed date to complete the assigned task. Drag the date in the calendar to set

Bid Duration Proposed amount of hours to complete the assigned task.
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Gantt Widget

Description

The Gantt Widget displays a horizontal bar graph representing the item's start date, end date and duration. The bar
graph can be clicked on and dragged to manipulate schedules for projects and task schedules. The widget has 2 view
modes: weeks and months view.

Usage

View modes: Toggle the Gantt Widget between the 2 viewing modes by double clicking on the column header.

view mode: months

view mode: days

Start/End Date: Modify the start and end dates by left clicking and dragging them.

Hover Pop-up: Hover the cursor over the horizontal bars to pop-up a window that displays the dates of the schedule.

Shifting the bar: Click dragging the bar shifts the start and end dates bar while maintaining the duration.

Multi-selection Edit: First, check mark the items to be modified.

Adjust multiple start dates: With multiple items selected, click drag on one of the start dates to adjust all the start
dates simultaneously.
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Adjust multiple end dates: With multiple items selected, click drag on one of the end dates to adjust all the end
dates simultaneously.

Shift all the bars: With multiple items selected, click drag on one of the bars to shift all the start/end dates
simultaneously while maintaining the duration.

Shift the view: Click drag on an empty area of the Gantt Widget to the mouse left or right. The bars and the units
will shift while maintaining their values.

Scale the view: Hold down the shift key. Then, click and hold on an empty area of the Gantt Widget and drag the
cursor to the left or the right. The bars and the units will scale while maintaining their values.
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Notes

What are Notes?

Notes are the ideal communication tool to use to store the message thread that occurs between content creators,
supervisors, clients, etc.

TACTIC Notes are used to add and track comments on an item. A history of the previous notes are tracked with
the item and can be viewed in the notes history. Each note contains the process for the item, the timestamp, who
added the note and any file attachments. Optionally, each note can also be sent as an email and can be automated
with rules to send to the correct user groups. Notes can be associated to a pipleine process with Tasks and Check-ins
(Snapshots). Using this association, the communication of the progress of each individual can be accurately tracked
and retrieved by a supervisor at any time for a production to the smallest detail.



TACTIC End User

62

Notes Quick Start

1. First, load a view of items you wish to track notes for.

If the Notes column is not already in the view, it can be added through the column manager.

Note

In TACTIC 3.7+, the notes column can also be added to your view in the gear menu under Notes ->
Add Notes Column

2. Click the [+] on in the notes column on the item you wish to add a note to.

3. In the add dialog, first select the process. If no tasks are assigned the process will be "default" otherwise, the task
processes will be available in the list

4. Add the note then click submit.

Note

If notifications are setup, an email will also be sent for the note. If you would like to setup automated
emails Please review the Notifications section in the TACTIC Setup documentation.
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Notes Widget

Introduction

The Notes Widget provides the ability to add a note directly to an item in the view. The notes are tracked in
chronological order and and are also grouped by process if entered against tasks. Other conveniences provided in this
widget is the ability attach files and to CC/BCC extra email addresses when you submit the note.

Adding a Note

If the Notes widget is not in the view, it can be added through the Column Manager.

To add a note, go to the Notes column and click on the plus sign in the top right corner.

The "For process:" drop down allows you to select the pipeline process to add the note to. If there is no pipeline for
the item, then a default process will be used for the note.

The Submit button will save the note to the item.

Additional Note Options:

To attach a file, click on the Attach File(s) button. The file browser will open to prompt to select a file.
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Additional fields to input Cc or Bcc email addresses can be found at the bottom, under Mail Options.

Note

If Notification Triggers have been set up in the project, emails will automatially be sent to the appropriate
users when notes are added. Adding a CC email address to a note simply sends the note to the email
addresses regardless of Noification Triggers.

Multiple Notes

When multiple notes are saved to an item, the interface will look like the following (notice that the notes for the item
are conveniently categorized by process):

Collapsed

Expanded
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Note Sheet

Introduction

The Note Sheet widget provides a convenient layout for typing in notes for different processes in one concise user
interface. The Note Sheet is also built to provide rapid interface for entering notes. For example, the Note Sheet helps
in daily review sessions where the ability to enter notes in rapid succession is necessary.

Description

Notes can be entered for any item. When the Note Sheet widget is added as a column, by default, the pipeline processes
are used as the processes for note entry. The processes for the example item shown in the screen shot above include
design, final, rough and delivery. The Notes Sheet widget allows entering of many notes in different processes and
different parents at the same time. They can be saved either individually or altogether. The private check box option
make a note private.

Usage

When the Note Sheet is expanded, it may require that the processes be selected to display. At the top of the widget
is a button which allows you to load a process selection pop-up which exposes the desired processes.

After you are finished with note entry, you will two buttons appearing on the top right corner. Clicking on "save" will
save all of the notes. If you have the Note Sheet Widget opened for vehicle001, vehicle002, and vehicle003, clicking
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on the standard save all will save all new notes in the view. To save one note at a time, there is also an individual
"save" button for each process.

Clicking on the history button pops up a window which displays all the note entries under this particular context.

Private Notes

The private check box turns a note access to private if checked. The private option is a built in access rule which can
deny a group of users from being able to see notes flagged as 'private'.

Note

Note - When using the Note Sheet on items such as Tasks, Notes and Snapshots, the default assumption
will be to add a note to the parent item for the particular process. For example, if adding a note to the
"design" task, a note will be added with the same process.
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Checkin and Checkout

What are Check-ins?
Check-ins or "Snapshots" in TACTIC represent files, directories, sequences etc that are checked in from a users
computer to the servers central repository. This process is no different than if the user were to correctly name and place
the files on the server individually but, TACTIC handles this automatically resulting in a clean, organized repository.

As a user there is also no need to worry about the versioning files as this is automated through the snapshot records.
You simply choose which process the file is being checked into and TACTIC handles the rest.

When s file is checked in, an entry is created for that item which contain references to the process, version, date/time,
who did it and where the file is on the server. If tasks exist for the item, check-ins often occur against those tasks which
results in a direct relationship between the task and the check in providing a history of files for that particular process.

Naming Conventions

Naming conventions in TACTIC are used to automate the naming of the directories and files in the central repository.
Although strictly controlled, it is important to note that these conventions are configurable and are simply used to
guide where the files are stored. By default TACTIC is delivered with a set of naming conventions that often work
well.

How naming conventions work is that a check in occurs, TACTIC is able to use information about the item being
checked into, the task and the new version information to properly control where the files are copied to and what
they are named in the repository. For example if checking into "design" for "character001" and the next version is
4, the resulting file structure might look like:

my_project/assets/character001/design/character001_design_004.jpg

Latest and Current

When files are checked in, it is often good to know which version is the latest version. Although at times, the highest
version or last check in is not the version that should be delivered. "Current" is a way of flagging a check in as
the deliverable check-in regardless of what the version number is. For example, you may have versions 1-10 for a
"design" process but, version 7 is the approved deliverable check-in. Setting this check-in to "current" will flag it as
the deliverable for either downstream pipeline processes or, for final delivery.

Versionless

By default, TACTIC simply created a new version within a process each time a check in occurs. Users can then
checkout the desired version either by current/latest or by choosing a version. On top of this is the ability to generate
a latest or current versionless files each time the current/or latest changes either during a check in or manually in the
interface. This file is either a direct copy or a link depending on the setting in your project.

For more information on configuring version less check-ins, please review Project Automation -> Naming
Conventions in the TACTIC Setup Documentation.
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Check-in Quick Start

The simplest form of a check-in within TACTIC is to check-in a preview image for an item.

1. Locate an item you wish to check-in a preview for.

Note

If the preview column is not included in your view, you can add it through the Column Manager.

2. Right-Click on the item and in the context menu choose "Change Preview Image"

3. This will load a file browser where you can choose a preview image to check-in. Once the file has been uploaded,
the preview thumbnail will automatically update.

4. To view where the files were placed, expand the History column.

Note

If the History column is not in the view, it can be added with the Column Manager, or the view can be
changed to "Check-in" from the layout menu.

5. Look for your "icon" check-in. This is the snapshot entry where you will see the check-in information (version,
login, process, timestamp etc)

6. You can expand the "Files" column to see the location of the files in the central repository.
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General Check-ins

Introduction

The General Check-in widget provides an easy to use interface to do many of the most common kinds of check-ins
used in TACTIC. It is a highly configurable widget that allows a project to have customized check-ins for any part
of the content creation process.

Check-ins are the ability in TACTIC to take files that have been created and submit them to TACTIC's central
repository to be organized, stored and versioned. TACTIC has a comprehensive ability to track files and their histories
with the added benefit of enforcing naming conventions.

The General Check-in widget can handle:

• Single Files - An image, video, document, etc.

• Sequences - Commonly image sequences

• Directories - Full directories including files and sub folders

• Complex packages - Handling of a project source including project and source medial files.

Interface

The interface below shows a standard example of the General Check-in widget.
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Tool bar

The tool bar contains a number of useful functions.

Refresh Refreshes the whole Check-in widget and will also rescan the sandbox for any changes.

Browse to working folder Allows the user to browse to a new location for the work area.

Set to My Documents Sets the working area to the My Documents directory

Set to Desktop Sets the working area to the Desktop directory.

Browse Allows the user to select file(s) or directories to checkin directly.

Set Sandbox Set the sandbox automatically based on the naming conventions. This makes setting up
a workspace very easy and organized.

Check-out tools Tools to assist in Checking out files. Described in the section "Check-out" below

Explore Sandbox Opens up the folder directly on the users computer. This allows for the quick copying
and pasting files into your sandbox workspace.

Process Select

Check-ins for an item are always classified by a process. TACTIC organizes all of the check-ins with various processes
that are defined for that item. The current process can be selected by the process selection drop down. This often
times corresponds to a task assigned to that user for that process.

This will only show up if a pipeline has been defined for the item. If no pipeline has been defined, then a default
process called "publish" is used.

Often this selection will be locked because it is associated with an assigned task. A user will often work from a task
associated within a particular process and then choose to checkin files based on content created from this task.

Sandbox Area

On first load of a new task (process) the Check-in widget will assist the user in setting up a work area.

The user experience protocol will determine how the user leverages the features in the sandbox. The recommended
approach is to allow TACTIC to create a sandbox location for the current process. This method is beneficial because
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it helps the user organize work-up files before they are even checked into the server. This approach is recommended
because it creates an easily accessible and well organized file system on the user's computer. It is however, possible
to checkin files from another location on the file server using the browse buttons in the tool bar.

During the content creation process, users will create files and save them under this sandbox folder. All files associated
with this item should be stored here. It should be noted that this sandbox work area is not strictly enforced and it is
easy to navigate to other folders to checkin files to a given asset. However, it is considered good practice to have
users create files in a well defined location in order to more easily manage overall disk space usage.

Any files created in the sandbox area will be displayed in this section. If any new files have been created and are not
reflected in the interface, then a simple refresh should make these new files appear.

Files that have been checked-in will show a small indicator in the icon to the right and will be colored in blue. The
small indicator will either be a green check mark, which indicates that the file in the sandbox is identical to the
checked in file. If the indicator is a red exclamation mark, this means that the file has been changed and is different
from the checked-in file.

To select all files in the sandbox area check off the "Select/Deselect All" check-box on the top right hand side.

To quickly select all changed files, click on the arrow to open up extra menus and select "Select Changed Files".

All files that have been changed since the last checkin will be selected. TACTIC will remember the last subcontext
checked-in for this file. This allows changed files to be easily rechecked-in when changes have been made.

Clicking on the right mouse button of any file will open up a context menu.
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The following actions are available:

Open File Open the file using the application as setup by the client operating system.

Delete File Permanently delete the file from the sandbox area (and on the computer).

Properties Open up a pop-up showing the properties of this file, including all past checkin information.
An example is shown below:

Check-In

When any files are ready to be checked-in, they can be selected. The row will highlight for all selected files, and either
a selection list, or a text box will appear on the right side. Since many files can be checked into the same process in
an asset, this provides a sub-category to organize checked in assets (this is known as the subcontext of the context of
a check-in). By default, this should read (auto) which means that it will be automatically filled in.

When all of the files that need to be checked-in have been selected, the check-in widget will be enabled.

It's good practice to add a note in the Description field while performing a check-in. This is important so all project
users understand why a particular check-in was made, and where it's located.

When the "Check-in" button is pressed, all of the selected files will be transferred to TACTIC's repository. There are
a number of ways that the files can be configured to transfer files. When TACTIC checks in a file, it will move them
to the correct folder, version and rename them to the correct file name as specified for the naming conventions.

Check-in Subcontext types

When checking in, a drop-down is available beside each file or directory. This functionality allows control over how
each check-in will be handled. This type of control is called subcontext. This can be looked at as a sub process for
the sub-directories included in a check-in.

Auto

The "Auto" mode is used if it's desired to keep file names the same as they are before the checkin. This work-flow
is beneficial if one wishes to keep file names, or work in a situation such as subversion where files are constantly
overwritten and versions are handled automatically in the background.

Sandbox SANDBOX/project/assets/asset001/design/original_file.jpg

Check-in SERVER/project/assets/asset001/design/original_file.jpg

SERVER/project/assets/asset001/design/.versions/original_file_design_v001.jpg

Check-out SANDBOX/projcet/assets/asset001/design/original_file.jpg

Main
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If only one file/directory/sequence is going to be checked-in, it will also be re-named correctly by the naming
conventions. This is often the case when files are delivered to another department or the client.

Sandbox SANDBOX/projcet/assets/asset001/design/original_file.jpg

Check-in SERVER/project/assets/asset001/design/asset001_design_v001.jpg

Check-out SANDBOX/projcet/assets/asset001/design/asset001_design_v001.jpg

Text

If more than one file/directory will be checked in and strict control is required for each item, the subcontext will
be different each time a check-in happens. This often applies when different variations of a check-in are required.
For example a blue and a red version of a file might be needed for a particular check-in, so the user would type this
in for each file:

Sandbox SANDBOX/projcet/assets/asset001/design/original_file_red.jpg

SANDBOX/projcet/assets/asset001/design/original_file_blue.jpg

Check-in SERVER/project/assets/asset001/design/asset001_design_red_v001.jpg

SERVER/project/assets/asset001/design/asset001_design_blue_v001.jpg

Check-out SANDBOX/projcet/assets/asset001/design/asset001_design_red_v001.jpg

SANDBOX/projcet/assets/asset001/design/asset001_design_blue_v001.jpg

List

If more than one file/directory will be checked in and strict control is required for each item, the subcontexts are the
same every time a check-in occurs. This often applies when there are multiple sub-directories that need to be worked
on for a task. For example, a preview, project file and a directory of media files would be organized by selecting
preview, project or media in the drop-down.

Sandbox SANDBOX/projcet/assets/asset001/design/original_file_preview.jpg

SANDBOX/projcet/assets/asset001/design/original_file.psd

SANDBOX/projcet/assets/asset001/design/media/background.jpg

SANDBOX/projcet/assets/asset001/design/media/foreground.jpg

Check-in SERVER/project/assets/asset001/design/asset001_design_preview_v001.jpg

SERVER/project/assets/asset001/design/asset001_design_project_v001.jpg

SERVER/project/assets/asset001/design/asset001_design_media_v001

Check-out SANDBOX/projcet/assets/asset001/design/asset001_design_preview_v001.jpg

SANDBOX/projcet/assets/asset001/design/asset001_design_project_v001.jpg

SANDBOX/projcet/assets/asset001/design/asset001_design_media_v001

Note

Often these options are predetermined by the pipeline configuration set up by the TACTIC administrator.
Other combinations file/directory naming and file version control can also be configured through naming
conventions.
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Check-out

When working on a particular task that is part of a pipeline, files may need to be checked-out or "downloaded" to
be worked on or revised to complete the task. TACTIC assists with this process and allows easy access to retrieving
the right files/directories from the TACTIC server.

Check-out Options

A specific version can be checked out through the Check out button in the History area. There are also more advanced
options available in the Check-out options menu.

Check-out w/ Source
Name

Checks out a version based on the original file name that was checked-in regardless of
naming conventions.

Check-out w/
Repository Name

Versionless check-ins only - Check-out the version using the repository name.

Check-out w/
Versionless Name

Verisonless check-ins only - Check-out the version using the versionless convention.

History

This area shows the check-in history. By default, this information is collapsed but can be quickly shown by clicking
on Check-in history.
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Clipboard

Using the Clipboard

Introduction

The Clipboard menu feature provides an easy method for transferring items (row data) from one view to another.
Items can also be copied between different projects. This feature can be used similarly to the copy and paste function
that we are familiar with in most applications.

The Clipboard Menu Options

The features for the Clipboard can be found on the tool shelf under the Gear menu -> Clipboard.

The individual options of the Clipboard menu are described in detail below.

Copy Selected

This menu option copies the items to the Clipboard that you have checked marked in the view. Either one row or
multiple items can be copied. Once the items have been copied to the Clipboard in memory, the destination view has
been navigated to, to allow pasting the items.

Note

The Clipboard has been built with the ability to copy and paste items from one project to another.

Add Selected

This menu option copies the items that have been check marked and adds them to the items that are already have on
the Clipboard without wiping out what is on the Clipboard. This menu option is useful especially when navigating
through different views to gather row data.

Paste Clipboard

This menu option pastes the items that have been stored in the Clipboard into the view.

Note

Regarding copying and pasting to another project and the History column: After pasting the contents of
the Clipboard to the view, the latest History of the item's check-ins will refer to the item under the original
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path where the files live. The paths will point to the item in the new project as soon as the first check-in
transaction is completed for this item under the new project.

Show Clipboard Contents

This menu option opens up a pop up and displays the items that are currently stored in your Clipboard.
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Reporting

Charting

Tactic includes supprt for charting views in your project in different charting formats. These charts supply visual
representations of your data for use in reporting, statistics and data comparisions.

The various types of charts available are:

Line

Bar
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Bar3D

Some notes about charting

When creating a view to be charted, it is important that the view includes columsn which provide numerical based
data. This data is required to allow the chart to draw correctly.

You are able to have multiple data values on the data axis of the chart. For example if you have a view of assets and
want to iclude statistics on the total snapshots, total notes and total tasks the chart will be able to include all three.

Generating Charts

1. First create a view you wish to chart, in this case we will be using a 'file usage' view. This view shows the Mb
usage and snapshot count for all of the assets in the project.

2. In the table gear menu, there are 2 options:

• Chart items - charts all items in the system for the particular Search Type (in this example assets)

• Chart selected - charts all selected items in the view.
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3. In the gui, a chart will be generated with the assumed y-axis column being 'code' and the x-axis being all other
columns in the view. The setting for the cart can be further tweaked in the Chart specifications.
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Chart Specifications

search_type The Search Type the chart is being generated for.

chart_type The type of chart to generate. See the chart types below.

Y Axis The column to use for the y-axis

X Axis The column(s) to use for the x-axis

Saving Charts
Currently Charts cannot be saved. This will be included in a future release of Tactic.

Advanced
Axis Expressions

The charting Gui supports using expression directly for the x-axis. To do so:

1. In the chart specifications, hit the (+) to add a new x-axis value.

2. In the text field provide an expression. For example {@COUNT(sthpw/note)}

3. Refresh the chart and the expression will be evaluated as a column.
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Work Hours

Tracking User Work Hours

The TACTIC system has built-in work hour tracking, which can be tracked per task or work hours can be entered
manually.

By default, hours can only be submitted to a task by the user that task is assigned to. For example, if an asset has
a pipeline process called "texturing" and this process is assigned to the user Albert, then only Albert can log work
hours for this task.

Users log work hours in a task view with the "Work Hours" column.

Hours can be logged and edited per day, per task.

To view the logged hours, go to the Work Hours view. (This view shows the hours for the user currently logged in.)

In the Work Hours view, you will see an item per time entry with totals per day and per week based on hours logged
on all assets.

To manually track work hours for other events (for example, daily meetings), click the insert button and fill in the
options in the pop-up window:
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Options

Login The login (user) who the hours are for.

Day The day the hours are for.

Category The category of work the hours represent.

Description A description of what the time was spent on.

Straight Time The amount of hours for the entry.
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Transactions

Undo Your Actions
Similar to most software applications, TACTIC provides a convenient way to undo an action. Almost every action
in TACTIC is undo able. Transactions can include changes made to the database and to the file system (for example:
check-ins). One major benefit with TACTIC transactions is that they are not scoped to just your current session. If
you close down Tactic and log in a week later, you can still undo your last transaction.

The Undo action can be found by clicking on the top gear menu and choosing: Edit -> Undo Last Server Transaction

To see a list of the transactions which can be undone, click Show Server Transaction Log. (This log contains only
those actions completed by the user who is currently logged in.)

Notice the drop down selection menu provides a way to filter the transaction list by time.

To reverse the transactions directly from this log, click Undo to undo the most recent transaction in the log. Continue
back through the log, undoing one transaction at a time until the transaction to be undone is reached.

When a transaction is undone, it is relabeled with the type "redo" in the "Type" column. The original action can be
performed by clicking on the Redo button.
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V
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web browser, 5
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